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1. WYMOGI BEZPIECZEŃSTWA 
 

Poniższe wymogi bezpieczeństwa nie zawierają wszystkich informacji dotyczących działania 

urządzenia. Należy się zapoznać z niniejszą instrukcją obsługi w całości! 

 

UWAGA: Wszelkich podłączeń i zmian należy dokonywać przy odłączonym napięciu 

sieciowym i zasilającym. 

 

UWAGA:  Instalacja oraz programowanie urządzenia wymagają posiadania odpowiednich 

umiejętności, dlatego mogą być dokonywane tylko przez wykwalifikowany 

personel po zapoznaniu się z całą instrukcją obsługi. 

 

UWAGA:  Urządzenie musi być instalowane w dodatkowej skrzynce przeznaczonej do 

urządzeń elektrycznych. Musi ona chronić urządzenie przed dostępem osób 

niepowołanych, a w szczególności dzieci. Skrzynka musi również chronić 
urządzenie przed pyłem, wilgocią oraz innymi czynnikami mogącymi spowodować 
jego uszkodzenie. Skrzynka musi zapewnić odpowiednią temperaturę pracy 

urządzenia. 

 

UWAGA:  W przypadku, gdy urządzenie ulegnie uszkodzeniu należy skontaktować się ze 

sprzedawcą lub osobą odpowiedzialną za instalację.  
 

UWAGA:  Urządzenie musi być uziemione. Nie należy podłączać napięcia zasilającego przed 

upewnieniem się, że urządzenie jest odpowiednio uziemione. 

 

UWAGA: Wewnętrzne elementy urządzenia oraz jego obudowa mogą być gorące w trakcie 

działania oraz pozostać gorące nawet po odłączeniu zasilania. 

 

UWAGA:  Należy się upewnić czy zainstalowano odpowiednie zabezpieczenie na przewodach 

zasilających urządzenie, aby zapobiec jego uszkodzeniu. 

 

UWAGA:  Nieprawidłowo podłączone urządzenie może ulec uszkodzeniu. 

 

UWAGA:  Odpowiedzialność za prawidłową instalację urządzenia spoczywa na osobie 

montującej. Należy się upewnić czy spełnione zostają wszystkie wytyczne i normy 

obowiązujące w danym kraju.  

 

UWAGA: Wyładowania elektrostatyczne mogą uszkodzić urządzenie. Należy stosować 
odpowiednie zabezpieczenia. 

 

UWAGA: Wszelkie nieautoryzowane przeróbki, modyfikacje oraz próby naprawy powodują 
utratę gwarancji.  
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2. Wstęp 

 

 
Cyfrowy ściemniacz oświetlenia służy do regulowania jasności żarówek zwykłych (żarowych) lub 

halogenowych, zasilanych z sieci 230V~ 50Hz.  

 

Urządzenie nie jest przeznaczone do regulacji jasności świetlówek kompaktowych, 

jarzeniówek, lamp halogenowych zasilanych przez transformator (indukcyjny lub 

elektroniczny) oraz żarówek LED 230V~. Podłączenie lampy halogenowej zasilanej przez 

transformator może spowodować uszkodzenie lampy.  
 

Typowo urządzenie przewidziane jest do zastosowania w instalacjach inteligentnych budynków, 

gdzie określona liczba ściemniaczy odpowiada za pełne sterowanie oświetleniem budynku. 

Ściemniacz jest sterowany protokołem Modbus. Jest to standard przemysłowy w dziedzinie 

automatyki, którego dokumentacja jest w pełni jawna (znajduje się pod adresem 

http://www.modbus-ida.org/). Dzięki temu urządzenia oparte na protokole Modbus można 

wykorzystać w każdym systemie obsługującym ten standard. 

 

Maksymalny prąd obciążenia wynosi 3A. Układy mocy regulatora zabezpieczone są 
przeciwzwarciowo za pomocą bezpiecznika topikowego (F1 – 3.15A). Obwody niskonapięciowe są 
oddzielone galwanicznie od elementów będących pod napięciem sieci. Część niskonapięciowa 

może być zasilana napięciem od 9 do 24V prądu stałego, wymaga do 250 mA (typowo: 50 mA) 

prądu. W ściemniaczu można ustawić 100 poziomów jasności, natomiast wewnętrznie używanych 

jest 1000 poziomów dla zapewnienia płynnych zmian jasności. Szybkość zmian oświetlenia jest 

także regulowana, od natychmiastowego zapalania/gaśnięcia do trwającego 100 sekund 

rozjaśniania/ściemniania.  

 

Do ściemniacza bazowego mogącego sterować jednym obwodem oświetlenia można podłączyć 
6 urządzeń rozszerzających wykrywanych automatycznie. Daje to możliwość sterowania 

7 obwodami oświetlenia pod jednym adresem Modbus. 

 

 
 

Rys. 1. Widok ściemniacza SCB-3A 

\ 



 

 5 

3. Dane Techniczne 

 

Tabela 1. Rekomendowane warunki pracy 

Nazwa parametru Wartość 

Napięcie zasilania 230V~ 230V~ 

Minimalna moc odbiornika 25W 

Maksymalna moc odbiornika 600W 

Napięcie zasilania 24V= 9 - 24V= 

Prąd zasilania 24V= 50mA 

Napięcie na wyprowadzeniach SD, 

SCL 
0 - 5V= 

Temperatura pracy 0 – 70
o
C 

Wilgotność(1) 
5 – 95% 

Wysokość 0 – 2000 m n.p.m. 

Notka 1: Wilgotność bez kondensacji! 

 

 

4. Instalacja. 
 

4.1. Podłączenie obwodu elektrycznego. 

4.1.1 Rozmieszczenie konektorów ściemniacza. 
 

a) 

  

 

b)  

 

 

 

Rys. 2. Rozmieszczenie konektorów ściemniaczy: a) bazowego SCB-3A, b) rozszerzenia SCR-3A. 
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Opis konektorów: 

 
J202:   Złącze zasilania 230V AC 

J300B:  Złącze komunikacyjno - zasilające ściemniacza bazowego 

J300R:  Złącze komunikacyjno - zasilające rozszerzenia 

SW100:  Przełącznik adresu i prędkości transmisji danych ściemniacza bazowego 

SW200:  Przełącznik adresu rozszerzenia 

 

 

Uwaga: Podłączanie niezgodne z instrukcją może spowodować nieprawidłową pracę i/lub 

uszkodzenie urządzenia nie objęte gwarancją! 
 

 

4.1.2 Konektor zasilania stopnia mocy J202. 
 

 
 

Rys. 3. Widok konektora zasilania stopnia mocy (J202). 

 

 

Tabela 2. Opis wyprowadzeń na złączu J202: 

Numer 

wyprowadzenia 

Funkcja 

1 Wyjście fazy (L) 

2 Wyjście zera (N) 

3 Wyjście uziemienia (PE) 

4 Wejście fazy (L) 

5 Wejście zera (N) 

6 Wejście uziemienia (PE) 

 

 

 

Uwaga: Podłączenie obciążenia do pinów 4, 5, 6, a zasilania do 1, 2, 3 może spowodować 
nieprawidłową pracę układu i/lub uszkodzenie urządzenia. 
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4.1.3 Konektor J300B sygnałów sterujących i zasilania ściemniacza SCB-3A 

 
 

Rys. 4. Widok konektora J300B sygnałów sterujących i zasilania układu sterującego  

ściemniacza SCB-3A. 

 

Tabela 3. Opis wyprowadzeń na złączu J300B: 

Numer 

wyprowadzenia 

Funkcja 

1 D+ (RS-485) 

2 D - (RS-485) 

3 SDA (do podłączenia ściemniacza SCR-3A) 

4 SCL (do podłączenia ściemniacza SCR-3A) 

5 +24VDC 

6 GND (masa zasilania 24VDC) 

 

4.1.4 Konektor J300R sygnałów sterujących ściemniacza SCR-3A 

 
 

Rys. 5. Widok konektora J300R sygnałów sterujących i zasilania  

układu sterującego ściemniacza SCR-3A 

 

Tabela 4. Opis wyprowadzeń na złączu J300R: 

Numer wyprowadzenia Funkcja 

1 SDA (do podłączenia ściemniacza SCR-3A) 

2 SCL (do podłączenia ściemniacza SCR-3A) 

3 +24VDC 

4 GND (masa zasilania 24VDC) 
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4.1.5 Przykład typowego podłączenia do sterownika PLC FATEK. 
 

Na rysunku 6 pokazano przykład typowego podłączenia ściemniacza bazowego z jednym 

rozszerzeniem do sterownika PLC firmy Fatek przy pomocy interfejsu RS485. Kolejne rozszerzenia 

dołącza się równolegle, tak samo jak pierwsze. 

 

 
 

Rys. 6. Przykład typowego podłączenia ściemniaczy do sterownika PLC. 
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4.2 Instalacja mechaniczna, wymiary, mocowanie do szyny DIN 35 mm 
 

Na rysunku 7 pokazano wymiary obudowy ściemniacza. Obudowa jest przystosowana do montażu 

na szynie DIN 35mm. 

 

 
 

Rys. 7. Wymiary obudowy ściemniacza SCB-3A oraz SCR-3A. 

 

5. Konfiguracja 
 

5.1. Działanie urządzenia 
 

W momencie włączenia urządzenia CPU wykonuje test urządzenia, a także odczytuje parametry 

konfiguracyjne - ustawione adresy oraz prędkość komunikacji. W czasie uruchamiania następuje 

także automatyczne wykrycie ewentualnych rozszerzeń. Po około 1s od włączenia zasilania 

urządzenie jest gotowe do pracy. 

 

Ściemniacz posiada 27 rejestrów Modbus. Są one zaimplementowane jako 16-bitowe Holding 

Registers (4x) i 3 Input Register (3x). 

 

Lista rejestrów Modbus ściemniacza: 

 
31100 Autokonfiguracja  ściemniacz bazowy SCB-3A 

31101 Ilość kanałów  ściemniacz bazowy SCB-3A 

31102 Wersja oprogramowania  ściemniacz bazowy SCB-3A 

41200 Jasność kanał 1 ściemniacz bazowy SCB-3A 

41201 Krok kanał 1 ściemniacz bazowy SCB-3A 

41202 Jasność  kanał 2 rozszerzenie nr 1 SCR-3A 

41203 Krok kanał 2 rozszerzenie nr 1 SCR-3A 

41204 Jasność kanał 3 rozszerzenie nr 2 SCR-3A 

41205 Krok kanał 3 rozszerzenie nr 2 SCR-3A 

41206 Jasność kanał 4 rozszerzenie nr 3 SCR-3A 

41207 krok kanał 4 rozszerzenie nr 3 SCR-3A 
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41208 Jasność kanał 5 rozszerzenie nr 4 SCR-3A 

41209 Krok kanał 5 rozszerzenie nr 4 SCR-3A 

41210 Jasność kanał 6 rozszerzenie nr 4 SCR-3A 

41211 Krok kanał 6 rozszerzenie nr 5 SCR-3A 

41212 Jasność kanał 7 rozszerzenie nr 6 SCR-3A 

41213  Krok kanał 7 rozszerzenie nr 6 SCR-3A 

41214  zarezerwowany  ściemniacz bazowy SCB-3A 

41215  zarezerwowany  ściemniacz bazowy SCB-3A 

41216  Adres ostatniego ściemniacza  ściemniacz bazowy SCB-3A 

41217  Ilość wykrytych ściemniaczy  ściemniacz bazowy SCB-3A 

41218 Wykryto ściemniacz o adresie 1  ściemniacz bazowy SCB-3A 

41219  Wykryto ściemniacz o adresie 2  ściemniacz bazowy SCB-3A 

41220 Wykryto ściemniacz o adresie 3  ściemniacz bazowy SCB-3A 

41221 Wykryto ściemniacz o adresie 4  ściemniacz bazowy SCB-3A 

41222 Wykryto ściemniacz o adresie 5  ściemniacz bazowy SCB-3A 

41223 Wykryto ściemniacz o adresie 6  ściemniacz bazowy SCB-3A 

41224 Wykryto ściemniacz o adresie 7  ściemniacz bazowy SCB-3A 
 

 

5.2. Opis rejestrów Modbus: 
 

Rejestr „Autokonfiguracja” zawiera wartość identyfikującą urządzenie jako ściemniacz (117). 

Rejestr „Ilość kanałów” zawiera ilość zainstalowanych kanałów oświetlenia. Jest on kopią rejestru 

„Ilość wykrytych ściemniaczy”. Te dwa rejestry mogą być wykorzystane do autokonfiguracji 

systemu automatyki domowej. Rejestr „Wersja oprogramowania” zawiera numer wersji 

oprogramowania znajdującej się w ściemniaczu bazowym, w formacie xxx. Aby otrzymać 
rzeczywisty numer wersji oprogramowania, należy dodać kropki między xxx. Czyli odczytany 

numer wersji oprogramowania 124, to rzeczywista wersja firmware 1.2.4. 

 

5.2.1. Sterowanie jasnością za pomocą ściemniacza od wersji 1.2.6 urządzenia 
 

Od wersji 1.2.6 urządzenia zmieniono sposób sterowania jasnością. Pojedynczy obwód oświetlenia 

sterowany jest przez dwa rejestry Modbusa: „Jasność” i „Krok”.  

 

Wartość w rejestrze „Jasność” odpowiada za poziom jasności żarówki i może przyjmować wartości 

0..100, gdzie 0 oznacza żarówkę zgaszoną, a 100 - pełną jasność. Wartości pośrednie odpowiadają 
pośrednim stopniom jasności, np. wartość 50 odpowiada jasności połowicznej.  

 

Wartość w rejestrze „Krok” odpowiada za szybkość zmian jasności. Może on przyjmować wartości 

od 0 do 50, gdzie 0 to natychmiastowa zmiana (bez ściemniania/rozjaśniania), 1 to najszybsza 

zmiana, a 50 najwolniejsza. Krok równy 1 oznacza, iż ściemniacz zmienia jasność o 1 poziom na 

10ms (milisekund). Krok równy 50 oznacza zmianę o 1 poziom na 500 ms. 

 

Tabela 5. Czas trwania zmian jasności oświetlenia  

w zależności od wartości kroku 

Lp. 
Wartość 

kroku 

Zmiana 
jasności 

o 1 poziom 
w ciągu …  

[ms] 

Całkowity czas 
ściemniania/ 

rozjaśniania od 
0..2000 [s] 

1 0 0 0 

2 1 1 2 

3 2 2 4 

4 3 3 6 

5 4 4 8 
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6 5 5 10 

7 6 6 12 

8 7 7 14 

9 8 8 16 

10 9 9 18 

11 10 10 20 

12 11 11 22 

13 12 12 24 

14 13 13 26 

15 14 14 28 

16 15 15 30 

17 16 16 32 

18 17 17 34 

19 18 18 36 

20 19 19 38 

21 20 20 40 

22 21 21 42 

23 22 22 44 

24 23 23 46 

25 24 24 48 

26 25 25 50 

27 26 26 52 

28 27 27 54 

29 28 28 56 

30 29 29 58 

31 30 30 60 

32 31 31 62 

33 32 32 64 

34 33 33 66 

35 34 34 68 

36 35 35 70 

37 36 36 72 

38 37 37 74 

39 38 38 76 

40 39 39 78 

41 40 40 80 

42 41 41 82 

43 42 42 84 

44 43 43 86 

45 44 44 88 

46 45 45 90 

47 46 46 92 

48 47 47 94 

49 48 48 96 

50 49 49 98 

51 50 50 100 

 

 

Do rejestrów, które są oznaczone jako zarezerwowane, nie należy nic zapisywać, a wartości z nich 

odczytane są niezdefiniowane. Rejestry o adresach 41126..41224 to rejestry diagnostyczne, 

przeznaczone wyłącznie do odczytu. W rejestrze 41216 przechowywany jest najwyższy wykryty 

adres rozszerzenia. W rejestrach 41218..41224 przechowywane są wykryte adresy rozszerzeń. Są to 

rejestry wyłącznie do odczytu. Rejestr 41217 zawiera liczbę wykrytych rozszerzeń wraz ze 

ściemniaczem bazowym w zakresie 1..7 (1 – baza, 2 do 7 – rozszerzenia). W przypadku, gdy 
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podłączona jest sama baza, a ilość ta wynosi zero, może to świadczyć o uszkodzeniu płytki. 

 

 

5.3. Diody sygnalizacyjne.  
 

5.3.1. Diody sygnalizacyjne ściemniacza bazowego SCB-3A. 

 

 
Rys. 8. Diody sygnalizacyjne ściemniacza bazowego SCB-3A. 

 

Opis diod ściemniacza bazowego: 

 
D1: Odbiór RS-485: miganie kontrolki oznacza odbieranie danych po RS-485, 

D2: Nadawanie RS-485: miganie kontrolki oznacza wysyłanie danych po RS-485, 

D3: Kontrolka CPU: miganie oznacza poprawną pracę CPU, 

D4: Zasilanie CPU: zapalona oznacza obecność napięcia zasilającego CPU. 

 

Nieprzerwane świecenie się obu diod (TX, RX), lub tylko jednej (RX lub TX) sygnalizuje 

możliwość błędu w podłączeniu przewodów sygnałowych do gniazda zasilająco-komunikacyjnego 

lub błędnego ustawienia adresu ściemniacza. Miganie tylko diody sygnalizującej odbieranie danych 

przez ściemniacz sygnalizuje możliwość ustawienia błędnego adresu, wybranie błędnych 

parametrów transmisji (nieprawidłowa prędkość, ustawienia parzystości, liczba bitów stopu, itp.). 

 
5.3.2. Diody sygnalizacyjne rozszerzenia SCR-3A. 

 
1 2

LED 
 

Rys. 9. Diody sygnalizacyjne rozszerzenia SCR-3A  

 
D1: Kontrolka CPU - miganie diody oznacza poprawną pracę CPU 

D2: Zasilanie CPU - świecąca dioda oznacza obecność napięcia zasilającego CPU 
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5.4. Zworki konfiguracyjne. 

 

5.4.1. Ustawianie adresu Modbus za pomocą switcha SW100 

 

 
 

Rys. 10. Switch SW100 do ustawiania adresu Modbus (zworki 1-5)  

 

W położeniu przedstawionym na widoku płytki, zworka w pozycji OFF oznacza 1,  

w pozycji ON – 0.  

 

W switchu SW100 zworki 1..5 służą do ustawienia adresu w protokole Modbus: 

1 – A0 (najmniej znaczący bit adresu - LSB), 

2 – A1, 

3 – A2, 

4 – A3, 

5 – A4 (najbardziej znaczący bit adresu - MSB). 

 

Adres ściemniacza w protokole Modbus: 

- ustala się sprzętowo za pomocą switcha SW100,  

- może przyjmować wartości 1..31,  

- adres 0 jest zarezerwowany w specyfikacji protokołu Modbus jako rozgłoszeniowy (broadcast),  

- ustawia się w postaci binarnej, tzn. 27 (dec) = 011011 (bin). Switch w pozycji ON to bit adresu 

ustawiony jako 0. Switch w pozycji OFF to bit adresu ustawiony jako 1.  

 

Uwaga: Aby zmienić adres ściemniacza w protokole Modbus, adres rozszerzenia lub prędkość 
transmisji, należy ustawić żądane parametry, a następnie wyłączyć i włączyć zasilanie. 

Zmiana parametrów przy włączonym zasilaniu nie odniesie skutku. Nastąpi to dopiero przy 

następnym uruchomieniu urządzenia. 
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5.4.2. Ustawianie prędkości transmisji za pomocą switcha SW100. 
 

Zworka 6 ze switcha SW100 służy do ustawiania prędkości transmisji: 

ON – prędkość 9600 bps 

OFF – prędkość 57600 bps 

 

Uwaga: W ściemniaczu i urządzeniu nim sterującym muszą być ustawione takie same 

parametry transmisji! 

 

5.4.3. Konfiguracja switcha SW200. 

 

 
 

Rys. 11. Switch SW200 

 

SW200 służy do ustawiania adresu rozszerzenia (A0..A2): 

Zworka 1 - A0 

Zworka 2 - A1 

Zworka 3 - A2 

 
 

Rys.12 Konfiguracja switcha SW200. 

 

Switch SW200 wygląda i jest konfigurowany tak jak switch SW100 ściemniacza bazowego.  Służy 

do ustawiania adresów rozszerzeń, które powinny przyjmować różne wartości w zakresie 2..7. 

Ściemniacz na płytce bazowej ma zawsze adres 1. 
 
5.5. Protokół transmisji danych 

 
Ściemniacz komunikuje się z urządzeniem sterującym za pomocą protokołu Modbus. W warstwie 

fizycznej połączenie jest realizowane za pomocą dwuprzewodowego interfejsu RS-485 z transmisją 
half-duplex.  

 

Parametry transmisji: 

− Modbus:    RTU 

− prędkość:    przełączana zworką 9600/57600 bps 

− parzystość:    even 

− ilość bitów danych:   8 

− ilość bitów stopu:    1 
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Magistrala powinna być wykonana z 2 skręconych ze sobą przewodów.  

 

Uwaga: W ściemniaczu i urządzeniu nim sterującym muszą być ustawione takie same 

parametry transmisji! 

 

5.6. Komunikacja podłączenia ściemniacza do sterownika PLC Fatek 

 
Aby nawiązać komunikację ze ściemniaczem poprzez magistralę RS-485, należy najpierw 

skonfigurować port w sterowniku PLC. Możemy tego dokonać za pomocą programu  

WinProLadder. Wybieramy z menu: PLC → Setting → Port (numer portu, po którym będzie 

odbywała się komunikacja). Musi to być port, do którego przyłączona jest magistrala łącząca PLC 

ze ściemniaczem.  

 
 

Rys. 13. Wybór portu komunikacyjnego w oprogramowaniu narzędziowym  

sterownika PLC firmy FATEK 

 

 

 

Po wybraniu odpowiedniego portu musimy go skonfigurować. Ustawiamy następujące parametry 

transmisji: 

− prędkość (Baud Rate):    9600 (lub 57600) bps 

− parzystość: (Parity)    even 

− ilość bitów danych (Data Bit):   8 

− ilość bitów stopu (Stop Bit):   1 

− protokół:     Modbus RTU (slave) 

 

Uwaga: W ściemniaczu muszą być ustawione takie same parametry transmisji, jak w porcie 

sterownika, do którego jest podłączony! Nie oznacza to, że we wszystkich portach sterownika 

muszą być ustawione takie same parametry transmisji, jak w porcie do ściemniacza. 
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Rys. 14. Ustawienie parametrów transmisji sterownika PLC firmy FATEK. 
 

Sterownik ustawiony jako „master” musi mieć uruchomioną funkcję 150.M_BUS. W funkcji 

150.M_BUS (150) użytkownik ustawia tylko ten port, którego będzie używał do komunikacji, 

rejestr startowy programu do komunikacji oraz rejestr roboczy (rys. 15).  

 

Funkcja 150.M_BUS 

 
 

Rys. 15. Blok funkcyjny do obsługi komunikacji przy użyciu  

protokołu Modbus (funkcja: 150.M_BUS). 

 

 

 

Pt:   Numer portu w PLC, który ma być użyty do komunikacji, 

SR:   Rejestr startowy,  

WR:   Rejestr roboczy.  

 

Jeżeli wejście A/R = 0   - protokół Modbus RTU (domyślnie – wtedy, kiedy A/R jest niepodłączone) 

Jeżeli wejście A/R = 1   - protokół Modbus ASCII (nie jest obsługiwany przez ściemniacz). 

 

Jeżeli wejście ABT zmieni się na 1, operacja zostaje przerwana i po jej wznowieniu przesyłanie 

zaczyna się od pierwszego pakietu danych. Wyjścia ACT, ERR, DN sygnalizują odpowiednio: 

działanie, błąd i wykonanie transmisji. Mogą one być wykorzystywane do testowania 

i debuggowania połączenia, ale użycie ich nie jest wymagane. Kiedy port jest już skonfigurowany, 
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wstawiamy znacznik M192x, który będzie odpowiadał za wielkość odstępu czasowego pomiędzy 

kolejnymi transmisjami pakietów. 

 

M1920: 10ms (100Hz) 

M1921: 100ms (10Hz) 

M1922: 1s (1Hz) 

 

Następnie wstawiamy funkcję 150.M_BUS. Kiedy już zostanie skonfigurowany port oraz 

wstawiona funkcja 150.M_BUS,  musimy stworzyć tabelę. Z menu wybieramy: Project → ModBus 

Master Table → Add ModBus Master Table (rysunek 16 i 17). 

 

 
 

Rys. 16. Widok ekranu przy wstawianiu z menu tabeli  

do obsługi protokołu Modbus. 

 

 
 

Rys. 17. Widok ekranu przy wstawianiu z drzewa konfiguracji tabeli  

do obsługi protokołu Modbus. 

 

 

Po wybraniu Add ModBus Master Table pojawi się okno Table Edit (rys. 18).  
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Rys. 18. Okno konfiguracji funkcji Modbus w sterowniku FATEK. 

 

 

W polu Table Name użytkownik może wpisać dowolną nazwę np. modbus, natomiast w polu Table 

Starting Address należy wpisać rejestr startowy, który został użyty w programie w funkcji 

150.M_BUS, np.: R1000. Następnie po pojawieniu się okna Modbus Master Table można dodawać 
komendy (rys. 19).  

 

 
 

Rys. 19. Okno edycji komend. 

 

 

Po naciśnięciu przycisku Add pojawia się okienko Command Item, w którym należy wprowadzić 
numer stacji Slave Station (adres ściemniacza). Następnie należy wybrać rodzaj komendy 

(Read/Write), rozmiar przesyłanych danych, adres startowy w sterowniku „master” oraz adres 

startowy w ściemniaczu (lub innym urządzeniu) „slave”.  
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Przykładowa konfiguracja: 

 

Slave Station:   2 (adres fizyczny ściemniacza równy 2) 

Command:    Write (Zapis) 

Data Size:   14 ((poziom jasności, krok zmiany)* 7 kanałów)  

Master Data Start Address: np. R400 (wysyła wartości znajdujące się w rejestrach R400..R401) 

Slave Data Start Address: np. 401200  

Master Data Start Address:  Początek tabeli danych w PLC 

Slave Data Start Address:  Początek tabeli danych w ściemniaczu 

 

 

W przypadku, gdy podłączona jest mniejsza niż maksymalna (7) ilość ściemniaczy, dane dla 

nieużywanych kanałów nie muszą być wysyłane, np. gdy używamy jednego kanału wystarczy 

wysłać dane do rejestrów 1200..1201. 
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6. Przykład konfiguracji z panelem HMI firmy Weintek serii 500 

 
Podłączamy panel HMI do ściemniaczy według następującego schematu: 

 

 
 

Rys. 20. Schemat podłączenia panelu HMI firmy Weintek serii 500 do ściemniacza. 

 

Aby ściemniacz współpracował z panelem HMI, należy odpowiednio skonfigurować panel 

w programie EasyBuilder. 
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Konfigurujemy następujące parametry urządzenia i panelu (Menu: Edit → System Parameters) 

(rys. 21):  

 

 
Rys. 21 Konfiguracja parametrów komunikacji 

 

 

 

Przykładowa konfiguracja: 

PLC type: MODBUS RTU (485 2W)  

HMI model:  MT505T (model panelu HMI, który konfigurujemy) 

PLC I/F port:   RS-485 2W (port, którym łączymy się ze panelem HMI) 

Baud rate:  9600 bps 

Parity:  Even 

 

Na ekranie pojawia się wirtualny panel HMI, na którym możemy dodawać potrzebne elementy do 

sterowania ściemniaczem. Do sterowania parametrami ściemniacza można użyć przycisku do 

wpisywania liczb z klawiatury ekranowej (Numeric Input Extend) (rys. 21).  

 



 

 22 

 
Rys. 21 Wstawianie klawiatury ekranowej 

 

W oknie konfiguracyjnym podajemy następujące dane (rys. 22): 

 

 
Rys. 22. Okno konfiguracji przycisku do wpisywania wartości liczbowej w panelu HMI Weintek. 

 

 

Description:   Nazwa identyfikacyjna określonej klawiatury 

Device type:   4x (dla 16-bitowych Holding Registers 4x) 

Device address 1200 (podajemy tylko ostatnie 4 cyfry 1200, 1201, 1202 itd.) 

Trigger address:  LB 9000 (W przypadku niektórych typów paneli, aby zadziałała 

klawiatura ekranowa, musi być ustawiony dowolny bit. Aby uniknąć 
dodawania niepotrzebnych przycisków, można wykorzystać bit LB 

9000, który jest ustawiony na stałe). 



 

 23 

 

Kolejnymi ściemniaczami sterujemy tak samo. Kolejne klawiatury ekranowe konfigurujemy 

analogicznie jak w przykładzie powyżej, pamiętając jedynie o tym, by ustawiać odpowiednie adresy 

ściemniacza. Następnie zapisujemy program, kompilujemy i wysyłamy do naszego panelu: 

 

 

 
Rys. 23 Przycisk Download do kompilacji i wysyłania programu do panelu. 

 

 

Po poprawnym podłączeniu panel będzie sterować ściemniaczem w pełni samodzielnie. 
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7. Przykład konfiguracji z panelem HMI firmy Weintek serii 8000 

 
Podłączamy panel HMI do ściemniaczy według następującego schematu: 

 

 
 

Rys. 24 Schemat podłączenia panelu HMI firmy Weintek serii 8000 do ściemniacza.  
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Aby ściemniacz współpracował z panelem HMI, należy odpowiednio skonfigurować panel 

w programie EasyBuilder. 

 

Tworzymy nowy plik (Menu: File → New) (rys.25): 

 

 
Rys. 25: Okno ustawień początkowych programu. 

 

Po wybraniu odpowiedniego urządzenia (pole "Model", przykładowo "MT6050i (480 x 272)") oraz 

rodzaju wyświetlania (poziomo – "Landscape" lub pionowo "Portrait") automatycznie pojawia się 
okno "System Parameter Settings" (rys.26). Jeśli okno nie otworzy się automatycznie, można je 

otworzyć ręcznie (Menu: Edit → System Parameters).  

 

 
Rys. 16: Okno ustawień parametrów systemu (po zmianach). 
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W zakładce "Device" znajduje się lista aktualnie obsługiwanych urządzeń (domyślnie na liście jest 

panel dotykowy, który konfigurujemy). Aby program obsługiwał panel dotykowy wraz ze 

ściemniaczem, należy dodać nowe urządzenie do listy (przycisk "New" w zakładce "Device") 

(rys.27). 

 

 
Rys. 27: Okno ustawień urządzenia (po zmianach). 

 

Przykładowa konfiguracja dla ściemniacza: 

 

Name:   Nazwa (dowolna nazwa wybrana przez użytkownika) 

Location:   Local 

PLC type:   MODBUS RTU  

PLC I/F:   RS-485 2W 

COM:   COM1 (9600,E,8,1) – można zmienić te ustawienia, klikając "Settings" 

(rys.28). 
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Rys. 28: Okno zmiany parametrów transmisji danych (po zmianach). 

 

Po skonfigurowaniu połączenia, pojawia się wirtualne okno panelu HMI. Możemy rozmieszczać na 

nim okienka (przygotowane przez producenta) umożliwiające komunikację z urządzeniami 

i sterowanie ściemniaczem. Parametry ściemniacza możemy zmieniać np. poprzez klawiaturę 
ekranową. Aby umieścić obiekt tego typu na wirtualnym ekranie, należy wybrać "Numeric Input" 

z menu (rys.29). 

 

 
Rys. 29 Dodawanie elementu "Numeric Input". 
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Pojawia się okno konfiguracji klawiatury ekranowej (rys. 30)  

 

 
Rys. 30: Okno konfiguracyjne klawiatury ekranowej (po zmianach) 

 

Przykładowa konfiguracja: 

 

Description:  Nazwa identyfikacyjna określonej klawiatury 

PLC name:  MODBUS RTU 

Device type:  4x (16-bitowe Holding Registers)  

Address:  1201 (podajemy tylko ostatnie 4 cyfry) 

 

 
Rys. 31: Wygląd klawiatury  

na ekranie dotykowym. 
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Kolejne zakładki w oknie "New Numeric Input Objects" pozwalają na dokładniejsze 

skonfigurowanie klawiatury ekranowej (np. podanie zakresu wpisywanych liczb, zmianę wyglądu 

okienka na ekranie dotykowym, zmianę czcionki, zmianę umiejscowienia klawiatury na ekranie 

dotykowym itp.). Można ponownie otworzyć okno konfiguracyjne, podwójnie klikając na ramce 

reprezentującej dany obiekt (po jego umieszczeniu na wirtualnym ekranie). Kolejnym wygodnym 

i przejrzystym sposobem modyfikowania zmiennych jest suwak (slider). Wybieramy "Slider" 

z menu (podobnie jak w przypadku klawiatury ekranowej). 

 

Do konfiguracji suwaka służy okno "New Slider Object" – otwierane automatycznie (rys. 32). 

 

 
Rys. 32: Okno konfiguracyjne suwaka (po zmianach) 

 

Przykładowa konfiguracja: 

Description:   Nazwa identyfikacyjna określonej klawiatury 

PLC name:   MODBUS RTU 

Device type:   4x (16-bitowe Holding Registers)  

Address:   1200 (podajemy tylko ostatnie 4 cyfry) 

Address format: 16-bit (Unsigned) 

 

W zakładce "Outline" możemy ustawić parametry: zakres zmian, kolory, kształty itp. 

 

Kolejnymi ściemniaczami sterujemy tak samo. Kolejne klawiatury ekranowe konfigurujemy 

analogicznie jak w przykładzie powyżej, pamiętając jedynie o tym, by ustawiać odpowiednie 

adresy ściemniacza. Następnie zapisujemy program, kompilujemy i wysyłamy do naszego panelu 

(rys. 33). 
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Rys. 33: Zapis projektu i zaprogramowanie panelu dotykowego. 

 

8. Historia wersji instrukcji 
 

Lp. Data Wersja Opis 

1 8.02.2011 1.2.5->1.2.6 Zmiana sposobu sterowania jasnością 
2 9.03.2011 1.2.6 -> 1.2.7 Usunięcie diody sygnalizującej kierunek transmisji 

 

 

9. Uwagi końcowe 
 

1.  Producent zastrzega sobie prawo do wprowadzania ciągłych poprawek i ulepszeń. 
2.  Produkt może nieznacznie różnić się od fotografii. 

3.  Instrukcja może zawierać błędy. Producent nie odpowiada za jakiekolwiek uszkodzenia, które 

z nich mogą wyniknąć. Jednocześnie producent oświadcza, że dołoży wszelkich starań by żadne 

błędy w instrukcji się nie pojawiły a jeżeli tak się stanie to informacje o wszelkich błędach 

zamieści na swojej stronie internetowej.  

4.  Producent nie odpowiada za żadne szkody wynikające z użytkowania urządzenia. 

5.  Aktualna wersja instrukcji znajduje się na stronie www.esea.pl. 

6.  Wszelkie uwagi dotyczące urządzenia oraz tej instrukcji proszę kierować na email: 

info@esea.pl.    

 

 

 

 


